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BAB III 

METODOLOGI PENELITIAN 

3.1. Waktu dan Lokasi Penelitian 

Penelitian ini dilaksanakan pada bulan Maret sampai Juli 2022. Penelitian 

dilaksanakan di Laboratorium Riset Departemen Pendidikan Kimia Fakultas 

Pendidikan Matematika dan Ilmu Pengetahuan Alam Universitas Pendidikan 

Indonesia (FPMIPA UPI), Laboratorium Fisiologi Fakultas Kedokteran Universitas 

Brawijaya, dan tempat tinggal peneliti di Kecamatan Bojongloa Kaler, Kota 

Bandung, Jawa Barat melalui sistem dalam jaringan (daring) menggunakan 

software Molekuler docking. 

3.2. Alat dan Bahan 

3.2.1. Alat 

Alat yang digunakan untuk penelitian secara in vitro diantaranya neraca 

analitik Mettler Toledo ME204; vacuum rotary evaporator Buchi R3; Fourier 

Transform Infra Red Shimadzu 8400; Spektrofotometer UV-Vis mini Shimadzu 

1240; sentrifugator Corona 80-2; water bath EYELA SB-24; freezedryer; 

mikropipet; plat 96-well, hotplate dan stirrer CIMAREC+; sonikator LABOCON. 

Adapun alat yang digunakan untuk penelitian secara in silico diantaranya 

perangkat keras untuk sistem operasi berupa laptop dengan spesifikasi sebagai 

berikut: Prosesor 11th Gen Intel® Core™ i3-1115G4 @ 3,00 GHz (4CPUs), ~3,0 

GHz, RAM 8GB, 475GB SSD, dengan sistem operasi Windows 10 Home Single 

Language 64-bit; Perangkat lunak Avogadro; Orca 4.2.1; AutoDock Tools 1.5.6; 

AutoDock Vina 1.1.2; OpenBabel GUI 2.3.1; PyMOL 2.5.2; BIOVIA Discovery 

Studio Visualizer; dan situs SwissADME. 

3.2.2. Bahan 

Bahan yang digunakan dalam studi in vitro pada penelitian ini adalah 

biomassa Spirulina platensis dari PT. Amorina Kirana Adiwarna; etanol (pro analis, 

Merck) yang diencerkan menjadi 80%; kertas saring Whatman No.1 (ukuran pori 

11 µm); akuades; reagen Folin-ciocalteu (Merck); natrium karbonat (pro analis, 

Merck); asam galat (pro analis, May & Baker); reagen DPPH (Himedia); propilen 

glikol (Dow Chemical Pacific); gliserin; tiretanolamin (Petronas chemical); asam 

stearat (pro analis, Merck); setil alkohol (Croda chemical); emulgide; metil paraben 
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(Gilmart Organics); buffer fosfat 50 mM (pH 6,8); L-tirosin 2 mM; dimetil 

sulfoksida (DMSO); Tirosinase (333 unit/mL); HCl pekat (pro analis, Merck); 

reagen Mayer; kloroform (pro analis, Merck); H2SO4 pekat (pro analis, Merck); 

FeCl3 (pro analis, Merck); NaOH (PHILIP HARRIS). 

Adapun bahan yang digunakan untuk penelitian secara in silico meliputi 

struktur 3D senyawa fenolik pada Spirulina platensis yaitu asam galat (CID: 370); 

asam vanilat (CID: 8468); asam siringat (CID: 10742); asam protokatekhuat (CID: 

72); asam klorogenat (CID: 1794427); asam kafeat (CID: 689043); asam p-kumarat 

(CID: 637542); dan asam ferulat (CID: 445858) yang diperoleh dari database 

PubChem dengan format sdf. Adapun struktur 3D dari protein enzim tirosinase 

(PDB: 5M8M) diperoleh dari Protein Data Bank dengan format pdb. 

3.3. Prosedur penelitian 

Diagram alir prosedur penelitian secara in vitro (Gambar 3.1) meliputi uji 

fitokimia, uji total senyawa fenolik, uji FTIR, uji antioksidan metode DPPH, uji 

inhibisi terhadap tirosinase, formulasi tabir surya, dan uji nilai SPF tabir surya hasil 

formulasi. Diagram alir prediksi in silico meliputi validasi metode (Gambar 3.2), 

proses docking (Gambar 3.3), uji farmakokinetik (Gambar 3.4), dan perhitungan 

energi HOMO LUMO (Gambar 3.5). 

 

Gambar 3.1. Diagram alir penelitian in vitro. 

https://pubchem.ncbi.nlm.nih.gov/
https://www.rcsb.org/
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Gambar 3.2. Validasi metode docking. 

Gambar 3.3. Proses docking ligan senyawa fenolik dengan tirosinase. 

 

Gambar 3.4. Uji farmakokinetik kontrol positif dan ligan senyawa fenolik. 
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Gambar 3.5. Perhitungan energi HOMO LUMO ligan senyawa fenolik. 

3.3.1. Prosedur penelitian secara in vitro 

Pada studi in vitro terdapat beberapa tahapan yang meliputi preparasi 

sampel, preparasi ekstrak, uji fitokimia, kuantifikasi total kandungan fenolik, uji 

FTIR, uji aktivitas antioksidan, uji aktivitas inhibisi tirosinase, formulasi tabir 

surya, dan uji nilai SPF tabir surya hasil formulasi. 

 
3.3.1.1. Preparasi Sampel 

Biomassa Spirulina platensis diperoleh dari PT. Amorina Kirana Adiwarna, 

Jl. Ciumbuleuit, No. 73 Bandung, 40141, Jawa Barat, Indonesia. 

 
3.3.1.2. Preparasi Ekstrak Spirulina platensis 

Preparasi ekstrak S. platensis dilakukan melalui maserasi berdasarkan 

Rahim et al. (2021) dengan sedikit modifikasi. Ekstrak S. platensis dipreparasi 

dengan menimbang 30 g biomassa dan dilarutkan dalam 300 mL etanol 80% (grade, 

merk) selama 24 jam pada suhu ruang. Pelarut dievaporasi pada suhu 55°C 

menggunakan vacuum rotary evaporator. Ekstrak dalam bentuk pasta disimpan 

pada suhu 4°C kemudian dikeringkan dengan cara freezedrying. 

 
3.3.1.3. Uji Fitokimia Ekstrak Etanol Spirulina platensis 

Uji fitokimia ekstrak etanol S. platensis dengan merujuk pada metode Mane 

dan Chakraborty (2018). Pengujian fitokimia yang dilakukan meliputi golongan 

senyawa alkaloid, terpenoid, steroid, tanin, saponin, flavonoid, fenol, dan kumarin. 
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3.3.1.3.1 Uji Alkaloid 

Uji alkaloid dilakukan dengan menambahkan 2 mL HCl pekat ke dalam 2 

mL ekstrak S. platensis, dilanjut penambahan beberapa tetes reagen Mayer. 

Terbentuknya endapan putih mengindikasikan keberadaan alkaloid. 

 
3.3.1.3.2. Uji Terpenoid 

Uji terpenoid dilakukan dengan menambahkan 2 mL campuran kloroform 

dan asam sulfat pekat ke dalam 0,5 mL ekstrak S. platensis. Terbentuknya lapisan 

berwarna coklat kemerahan pada permukaan larutan menunjukkan keberadaan 

terpenoid. 

 
3.3.1.3.3. Uji Steroid 

Uji steroid dilakukan dengan menambahkan campuran 2 mL kloroform dan 

1 mL asam sulfat ke dalam 0,5 mL ekstrak S. platensis. Terbentuknya cincin 

berwarna coklat mengindikasikan keberadaan steroid. 

 
3.3.1.3.4. Uji Tanin 

Uji tanin dilakukan dengan menambahkan 1 mL FeCl3 5% ke dalam 1 mL 

ekstrak S. platensis. Terbentuknya warna biru atau hijau kehitaman 

mengindikasikan keberadaan tanin. 

 
3.3.1.3.5. Uji Saponin 

Uji saponin dilakukan dengan menambahkan 2 mL akuades ke dalam 2 mL 

ekstrak S. platensis, dilanjut pengocokan dalam gelas ukur selama 15 menit. 

Terbentuknya 1 cm lapisan buih mengindikasikan keberadaan saponin. 

 
3.3.1.3.6. Uji Flavonoid 

Uji flavonoid dilakukan dengan menambahkan 1 mL NaOH 2 N ke dalam 2 

mL ekstrak S. platensis. Perubahan warna larutan menjadi warna kuning 

mengindikasikan keberadaan flavonoid. 
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3.3.1.3.7. Uji Fenol 

Uji keberadaan fenol dilakukan dengan menambahkan 2 mL akuades ke 

dalam 1 mL ekstrak S. platensis, dilanjut penambahan beberapa tetes 10% FeCl3. 

Perubahan warna larutan menjadi warna biru atau hijau mengindikasikan 

keberadaan fenol. 

 
3.3.1.3.8. Uji Kumarin 

Uji kumarin dilakukan dengan menambahkan 1 mL NaOH 50% (b/b) ke 

dalam 1 mL ekstrak S. platensis. Perubahan warna menjadi warna kuning 

mengindikasikan keberadaan kumarin. 

 
3.3.1.4. Analisis FTIR Ekstrak Spirulina platensis 

Analisis FTIR ekstrak S. platensis dilakukan berdasarkan metode Zghari et 

al. (2017). Sampel ekstrak S. platensis dipindai pada panjang gelombang 4000-400 

cm-1 dengan resolusi 4 cm-1. Pemindaian dilakukan sebanyak 16 kali dan puncak 

yang diperoleh merupakan rata-rata dari 16 kali pemindaian. 

3.3.1.5. Kuantifikasi Total Kandungan Fenolik dalam Ekstrak Spirulina 

platensis 

Kuantifikasi total kandungan fenolik ekstrak S. platensis dilakukan 

berdasarkan metode Chatatikun & Chiabchalard (2013) dan Maciel et al. (2011). 

Ekstrak S. platensis sebanyak 500 mg dilarutkan ke dalam akuades 50 mL, dengan 

demikian diperoleh konsentrasi ekstrak 10.000 ppm. Sebanyak 0,5 mL ekstrak 

ditambahkan 2,5 mL larutan folin 10%, dilanjut penambahan larutan natrium 

bikarbonat (20% b/v) sebanyak 2 mL. Selanjutnya campuran diinkubasi selama 5 

menit pada water bath dengan suhu 50 °C. Absorbansi kompleks biru dievaluasi 

pada panjang gelombang 760 nm menggunakan spektrofotometer UV-Vis. Larutan 

standar asam galat dibuat dengan melarutkan asam galat ke dalam akuades dengan 

konsentrasi 3,125; 6,25; 12,5; 25; 50; dan 100 (mg/L). Akuades digunakan sebagai 

blanko. Total kandungan fenolik diekspresikan sebagai mg gallic acid equivalent 

(GAE) per gram ekstrak S. platensis. 
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3.3.1.6. Uji Aktivitas Antioksidan dari Ekstrak Spirulina platensis 

Aktivitas antioksidan dari ekstrak Spirulina platensis diuji menggunakan 

metode DPPH dengan merujuk pada metode Molyneux P. (2004). Ekstrak Spirulina 

platensis ditimbang sebanyak 0,1 g kemudian dilarutkan dalam etanol sebanyak 10 

mL dengan bantuan sonikator. Larutan ekstrak disentrifugasi dengan kecepatan 

10.000 rpm selama 10 menit, filtrat diambil untuk pengujian antioksidan. Larutan 

stok sampel diencerkan menjadi 1000; 100; 50; 12,5; 6,25; dan 3,125 ppm dengan 

penambahan etanol dan DPPH. Larutan diinkubasi selama 30 menit dan diukur 

absorbansinya pada 517 nm. 

 
3.3.1.7. Uji Aktivitas Inhibisi Tirosinase dari Ekstrak Spirulina platensis 

Uji aktivitas anti tirosinase dilakukan secara spektrofotometri dengan 

ELISA microplat reader berdasarkan metode Dolorosa et al. (2019). Ekstrak etanol 

S. platensis ditimbang sebanyak 200 mg dan dilarutkan ke dalam DMSO sebanyak 

100 mL, dengan demikian diperoleh konsentrasi larutan induk sebesar 2000 ppm. 

Larutan induk ekstrak diencerkan ke konsentrasi 1.000, 500, 250, 100, dan 10 ppm 

menggunakan buffer fosfat 50 mM (pH 6,8). Kemudian masing-masing larutan 

hasil pengenceran diambil sebanyak 70 µL dan diteteskan ke 96-well plate, dilanjut 

penambahan enzim tirosinase (333 unit/mL dalam buffer fosfat pH 6,8) sebanyak 

30 µL, dan substrat L-tirosin 2 mM sebanyak 10 µL. Campuran ekstrak, enzim, dan 

substrat diinkubasi selama 30 menit pada suhu ruang, kemudian diukur 

absorbansinya pada 475 nm untuk menentukan % inhibisi. Langkah pengujian yang 

sama diulang untuk kontrol positif asam kojat. 

 
3.3.1.8. Formulasi Tabir Surya 

Formulasi tabir surya dilakukan berdasarkan Mishra et al. (2014) dengan 

modifikasi. Bahan fasa air dan fasa minyak dipanaskan secara terpisah pada suhu 

70–75°C sampai melebur. Kemudian fasa air dan fasa minyak dicampurkan sedikit 

demi sedikit dengan kecepatan pengaduk yang konstan. Ekstrak S. platensis 

ditambahkan ke dalam sediaan krim pada suhu ±40°C. Formulasi tabir surya 

tercantum pada Tabel 3.1. 
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Tabel 3.1. Formulasi tabir surya. 

 

Bahan 
Krim A Krim B Krim C Krim D 

(gram) 

Fasa Air 

Propilen glikol 0,25 0,25 0,25 0,25 

Gliserin 0,24 0,24 0,24 0,24 

TEA (trietanolamin) 0,05 0,05 0,05 0,05 

Akuades 3,65 3,60 3,55 3,75 

Fasa Minyak 

Asam stearat 0,2 0,2 0,2 0,2 

Setil alkohol 0,1 0,1 0,1 0,1 

Emulgide 0,4 0,4 0,4 0,4 

Bahan Tambahan 

Metil paraben 0,01 0,01 0,01 0,01 

Ekstrak etanol S. platensis 0,1 0,15 0,2 - 

 

3.3.1.9. Uji Nilai SPF Tabir Surya hasil Formulasi 

Pengujian nilai Sun Protection Factor (SPF) dilakukan melalui 

spektrofotometri UV-Vis berdasarkan Sayre et al. (1979). Sebanyak 400 mg sampel 

dilarutkan ke dalam etanol 25 mL sampai homogen. Absorbansi diukur pada 

panjang gelombang 290–320 nm. Serapan rerata (Abs) ditentukan dengan interval 

5 nm. Spektrum Efek Eritemal (EE) adalah jumlah minimal sinar UV yang 

dibutuhkan untuk menimbulkan eritema (kemerahan). Nilai EE × I (Tabel 3.2) 

adalah konstanta yang nilainya sudah ditetapkan berdasarkan Sayre et al. (1979). 

Tabel 3.2. Data nilai EE × I pada rentang panjang gelombang 290–320 nm. 

 
Panjang Gelombang (λ) nm EE × I 

290 

295 

300 

305 

310 

315 

320 

Total 

0,0150 

0,0817 

0,2874 

0,3278 

0,1864 

0,0839 

0,0180 

1,0000 
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Data yang diperoleh diolah menggunakan persamaan Mansur (Zarkogianni 

& Nikolaidis, 2016) yang tertera di bawah ini: 

 

320 

𝑆𝑃𝐹 = 𝐶𝐹 × ∑ 𝐸𝐸(𝜆) × 𝐼(𝜆) × 𝑎𝑏𝑠(𝜆) 

290 

CF: Faktor koreksi 

EE: Spektrum efek eritemal 

I: Spektrum intensitas UVB (290-320 nm) 

Abs: Absorbansi sampel 

 
3.3.2. Prosedur penelitian secara in silico 

Penelitian secara in silico dilakukan dengan menggunakan simulasi 

molekuler docking. Masing-masing protein diuji aktivitas pembentukkan ikatan 

dengan tirosinase. Pada studi in silico terdapat beberapa tahapan yang meliputi 

preparasi protein tirosinase, preparasi ligan, perhitungan dan validasi molekuler 

docking, dan visualisasi molekuler docking. 

 
3.3.2.1. Preparasi Protein Tirosinase 

Protein yang digunakan pada uji in silico adalah enzim tirosinase (5M8M) 

yang diunduh strukturnya (3D) dari Protein Data Bank dengan format .pdb. Struktur 

protein yang diunduh masih mengandung pelarut (air) dan residu lainnya. Preparasi 

protein dilakukan menggunakan aplikasi AutoDock Tools 1.5.6 dengan 

menghilangkan pelarut (semua molekul air), kristal pelarut, dan ligan natif. 

Langkah tersebut dilakukan agar tidak mengganggu proses docking, sehingga 

interaksi hanya terjadi pada ligan (senyawa fenolik) dan protein (tirosinase). 

Selanjutnya, salah satu rantai protein dipilih dan ligan native yang terikat pada 

protein dipisahkan dari molekul protein. Hasil preparasi protein disimpan dalam 

format .pdb. Hidrogen pada file .pdb hasil preparasi sudah dihilangkan, sehingga 

dilakukan penambahan atom hidrogen polar dan Gasteiger charge pada struktur 

(Khedidja et al., 2018). Penambahan atom hidrogen polar dilakukan untuk 

menyesuaikan suasana docking mendekati pH 7 (suasana pH dalam tubuh) dan 

https://www.rcsb.org/
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interaksi ikatan hidrogen pada struktur protein dengan ligan dapat diamati. 

Penambahan Gasteiger charge dilakukan untuk menyesuaikan dengan suasana 

penambatan molekul, sehingga perhitungan yang lebih akurat dapat diperoleh 

(Bikadi & Hazai, 2009). Kemudian, grid box diatur untuk sisi pengikatan pada 

protein dengan ligan. Pengaturan tersebut disimpan dalam format .txt. 

 
3.3.2.2. Preparasi Ligan (Senyawa Fenolik) 

Struktur 3D dari asam galat (CID: 370); asam vanilat (CID: 8468); asam 

siringat (CID: 10742); asam protokatekhuat (CID: 72); asam klorogenat (CID: 

1794427); asam kafeat (CID: 689043); asam p-kumarat (CID: 637542); dan asam 

ferulat (CID: 445858) diperoleh dari database PubChem dengan format sdf. 

Struktur tersebut diubah formatnya menjadi pdb menggunakan aplikasi OpenBabel 

GUI 2.3.1. Tahapan selanjutnya yaitu optimasi geometri struktur ligan 

menggunakan perangkat lunak Avogadro. Langkah tersebut dilakukan untuk 

memperoleh struktur molekul yang paling stabil dan memiliki energi potensial yang 

lebih rendah. Tahapan optimasi geometri dilakukan dengan cara Extensions > 

Optimize Geometry > kembali ke Extensions > Molecular Mechanics > Setup Force 

Field > pilih MMFF94 sebagai Force Field > Number of Steps diatur menjadi 50 > 

klik OK > kembali ke Extensions > Conformer Search > Genetic algorithm search 

> Number of conformers diatur menjadi 200 > klik OK. Kemudian, ligan senyawa 

fenolik dipreparasi menggunakan perangkat lunak AutoDock Tools 1.5.6. Tahapan 

preparasi ligan meliputi pengaturan torsi yang diatur dengan cara Ligand > Torsion 

Tree > Choose Torsion dan Ligand > Torsion Tree > Set Number of Torsion, 

selanjutnya disimpan dengan format .pdbqt melalui Ligand > Output > Save as 

PDBQT. 

 
3.3.2.3. Perhitungan dan Validasi Molekuler Docking 

Validasi metode docking dilakukan menggunakan metode pose selection 

yaitu ligan yang telah diketahui orientasi dan konformasi pada sisi aktif reseptor 

protein di-docking kembali. Validasi metode docking dilakukan untuk 

memverifikasi reliabilitas simulasi docking (Lin et al., 2014). Senyawa fenolik dan 

peptida yang telah dipreparasi dibuat file config untuk simulasi molekuler docking. 

https://pubchem.ncbi.nlm.nih.gov/
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Analisis docking molekul dilakukan menggunakan AutoDock Vina pada AutoDock 

Tools dengan Command prompt: vina –config conf.txt –log log.txt. Hasil docking 

akan diperoleh dalam bentuk prediksi struktur dan nilai energi gibbs (-). Afinitas 

pengikatan molekul dikatakan baik apabila energi bebas gibbs senyawa fenolik dan 

peptida lebih rendah atau memiliki nilai afinitas pengikatan yang besar (-) (Trott & 

Olson, 2009) jika dibandingkan dengan energi bebas gibbs inhibitor komersial. 

Hasil simulasi docking dikatakan valid apabila memenuhi nilai Root Mean Square 

Deviation (RMSD) kurang dari sama dengan 2 Å (Trott & Olson, 2009). Hal 

tersebut menandakan bahwa semakin kecil nilai RMSD, maka semakin dekat posisi 

ligan native hasil docking dengan ligan native hasil kristalografi. Nilai RMSD 

diperoleh dari perhitungan menggunakan perangkat lunak PyMOL. 

Posisi situs penambatan (grid box) pada proses redocking diatur sesuai 

dengan ukuran dan posisi inhibitor dengan tahapan Grid > Set Map Types > Choose 

Ligand, pilih Grid Box > Center > Center on Ligand Spacing Angstrom = 1. Ukuran 

grid box tidak lebih kecil ataupun terlalu besar dari ukuran ligan. Konfigurasi 

molekuler docking dibuat dan disimpan pada note dengan format .txt. Koordinat 

grid box untuk simulasi docking ligan uji berdasarkan hasil validasi metode 

ditunjukkan pada Tabel 3.3. 

Tabel 3.3. Koordinat grid box untuk simulasi molekuler docking 
 

Koordinat (Å) Ukuran (Å) RMSD 

(Å) X Y Z X Y Z 

-31,471 -3,610 -24,849 8 8 8 2 

 

3.3.2.4. Visualisasi Molekuler Docking 

Visualisasi molekuler yang terbentuk dilakukan dengan menggunakan 

perangkat lunak PyMoL dan BIOVIA Discovery Studio Visualizer. Visualisasi 

yang terbentuk dapat diamati dengan mengklik surface dan ligan melalui ball and 

stick. Gambar yang terbentuk disimpan dalam bentuk format .PNG. Posisi interaksi 

ligan dengan enzim diamati, sehingga letak dan interaksinya dapat dianalisis. Selain 

itu, pengamatan interaksi antara enzim dengan ligan dapat divisualisasikan dalam 

bentuk 2D maupun 3D pada BIOVIA Discovery Studio Visualizer. Interaksi yang 

teramati meliputi gaya Van der Waals, Ikatan hidrogen, Interaksi hidrofobik, serta 
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interaksi lain yang mungkin terbentuk seperti interaksi elektron bebas Pi (Guedes 

et al., 2011). Tabel 3.4 menunjukkan kategori ikatan hidrogen panjang ikatan yang 

terbentuk. 

Tabel 3.4. Klasifikasi jarak ikatan hidrogen (Guedes et al., 2011). 
 

No. Jarak (Å) Keterangan 

1. 2,2-2,5 Kuat 

2. 2,5-3,2 Moderat 

3. 3,2-4,0 Lemah 

 

3.3.2.5. Analisis Farmakokinetik Ligan Senyawa Fenolik dari Ekstrak Etanol 

Spirulina platensis 

Analisis farmakokinetik ligan senyawa fenolik dari ekstrak etanol Spirulina 

platensis dilakukan berdasarkan metode Julia & Komari (2022). Analisis 

farmakokinetik dilakukan melalui situs SwissADME dengan tahapan Import > 

Choose File > unggah ligan senyawa fenolik dengan format .sdf > klik tanda panah 

untuk mengonversi struktur menjadi kode SMILES > klik Run > Catat parameter 

farmakokinetik meliputi rumus struktur, berat molekul, jumlah donor ikatan H, 

jumlah akseptor ikatan H, LogP, dan keterangan Lipinski. 

 
3.3.2.6. Penentuan Energi HOMO dan LUMO 

Penentuan energi HOMO dan LUMO ligan senyawa fenolik diawali dengan 

pembuatan file input pada aplikasi Avogadro melalui tahapan File > Open > pilih 

struktur ligan dalam format .sdf > Extensions > Orca > Generate orca input > pilih 

Method DFT > atur basis set menjadi 631 > generate > beri nama dengan format 

nama_senyawa > klik OK. Selanjutnya, lakukan perhitungan pada Orca melalui 

Command Prompt dan beri nama output nama_senyawa.out. Hasil perhitungan 

energi HOMO dan LUMO diperoleh dengan membuka file nama_senyawa.out 

pada Avogadro dengan tahapan Open > pilih file nama_senyawa.out > catat energi 

HOMO dan LUMO. 

http://www.swissadme.ch/
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